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Oracle welcomes customers' comments and suggestions on the quality and usefulness 
of this document.

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example:

■ Are the implementation steps correct and complete?

■ Did you understand the context of the procedures?

■ Did you find any errors in the information?

■ Does the structure of the information help you with your tasks?

■ Do you need different information or graphics? If so, where, and in what format?

■ Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell 
us your name, the name of the company who has licensed our products, the title and 
part number of the documentation and the chapter, section, and page number (if 
available).

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number 
(optional).

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services. 

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at http://www.oracle.com.

Note: Before sending us your comments, you might like to check 
that you have the latest version of the document and if any concerns 
are already addressed. To do this, access the Online Documentation 
available on the Oracle Technology Network Web site. It contains the 
most current Documentation Library plus all documents revised or 
released recently.
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Preface

This guide describes the Category Management user interface. It provides step-by-step 
instructions to complete most tasks that can be performed through the user interface.

Audience
This User Guide is for users and administrators of Oracle Retail Product. This includes 
merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/support/contact.html or visit 
http://www.oracle.com/accessibility/support.html if you are hearing 
impaired.
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For more information, see the following documents in the Oracle Retail Category 
Management 13.3 documentation set:

■ Oracle Retail Category Management Release Notes

■ Oracle Retail Category Management Installation Guide

■ Oracle Retail Category Management Configuration Guide

■ Oracle Retail Category Management User Guide for the RPAS Fusion Client

■ Oracle Retail Predictive Application Server documentation set

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

■ Product version and program/module name

■ Functional and technical description of the problem (include business impact)

■ Detailed step-by-step instructions to re-create

■ Exact error message received

■ Screen shots of each step you take

Review Patch Documentation
When you install the application for the first time, you install either a base release (for 
example, 13.3) or a later patch release (for example, 13.3.1). If you are installing the 
base release, additional patch, and bundled hot fix releases, read the documentation 
for all releases that have occurred since the base release before you begin installation. 
Documentation for patch and bundled hot fix releases can contain critical information 
related to the base release, as well as information about code changes since the base 
release.

Oracle Retail Documentation on the Oracle Technology Network
Documentation is packaged with each Oracle Retail product release. Oracle Retail 
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Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1
Introduction 

Effective merchandising is the cornerstone of a successful retail business because it 
determines the variety and presentation of merchandise, which defines the customer's 
in-store experience. It is one of the most important aspects of a retailer's brand image. 
In recent years, retailers have experienced increased difficulty in achieving desired 
levels of same store sales growth, gross margin, and inventory productivity. This is 
due, in part, to smaller buying staffs, shorter product life cycles, increasingly savvy 
and demanding customers, and cutthroat competition.

In light of these issues, retailers are looking to service their customers, drive profitable 
growth, and further differentiate themselves from the competition by tailoring their 
product offerings to the needs of their local customers. In the past, 
micro-merchandising or local market assortments were extremely complex, labor 
intensive, and yielded marginal results. The Category Management solution is 
manageable and has a positive impact on business.

Category Management functionality was developed to address the crucial process of 
determining four primary merchandising dimensions:

■ Categories of merchandise carried within a store 

■ Space allocated to each category of merchandise 

■ Assortment of items carried in each category 

■ Space allocated to each item in each category

Note: There are two Category Management user guides: one for the 
Oracle Retail Predictive Application Server (RPAS) Fusion Client and 
one for the RPAS Classic Client. This guide describes Category 
Management on the RPAS Classic Client. 

For information about Category Management on the RPAS Fusion 
Client, see the Category Management User Guide for the RPAS Fusion 
Client.
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Category Management Business Process
The diagram below illustrates the process flow used for Category Management.

Figure 1–1 Category Management Business Process

The following sections contain the tasks that are accomplished in each step of the 
business processes, as well as the associated workflow tabs and worksheets.

Macro Rationalization
The following table contains the workflow tab, worksheets, and tasks for macro 
rationalization.

Table 1–1  Macro Rationalization

Workflow Tab Worksheet Task

Consumer Analysis Review Consumer 
Data

■ Review category performance using key 
performance indicator measures.

■ Review customer segment data.

■ Enter consumer segment notes.

Competitive 
Intelligence

Review Competitive 
Data

■ Review market share information by key 
competitor.

■ Enter competitor notes.

Category Analysis Review Category 
Performance

■ Review future demand by category.

■ Enter category performance notes.

Net Margin Analysis Review Net Margin 
Components

■ Review net margin components.

■ Review category net margin 
performance.

■ Enter category net margin notes.

Vendor Analysis Review Vendor 
Performance

■ Review category performance by vendor.

■ Enter vendor performance notes.
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Macro Space Optimization
The following table contains the workflow tab, worksheets, and tasks for macro space 
optimization.

Vendor Net Margin 
Analysis

Review Net Margin 
Components By 
Vendor"

■ Review category net margin performance 
by vendor.

■ Enter vendor new margin notes.

Category Scorecard Assign Role / Type ■ Assign category strategic role.

■ Indicate de-listed categories.

■ Indicate category mandatory status.

■ Enter scorecard notes.

Table 1–2  Macro Space Optimization

Workflow Tab Worksheet Task

Determine Optimal 
Space / Profit

Optimize Space and 
Profit"

■ View category role from Macro 
Rationalization step.

■ Check for de-listed recommendations 
from Macro Rationalization step.

■ Check mandatory status from Macro 
Rationalization step.

■ Indicate include status of category.

■ Review space data supplied by the space 
planning process.

■ Enter minimum and maximum space 
tolerance.

■ Review cluster level optimization results.

■ Enable data send to space planning.

■ Review space planning 
recommendations.

■ Re-optimize as necessary.

Optimization 
Constraints

■ Enter constraint type.

■ Enter in maximum floor space.

■ Enable optimize measure to run 
optimization routine

Review Store Results Review Store Results ■ Review by store space recommendations 
from space planning process.

■ If re-optimization is desired, enter store 
level minimum / maximum space 
tolerance.

■ Enable send data now measure to send 
store level data to space planning.

Optimize ■ Enable optimize measure to re-optimize.

Table 1–1 (Cont.) Macro Rationalization

Workflow Tab Worksheet Task
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Assortment Rationalization
The following table contains the workflow tab, worksheets, and tasks for assortment 
rationalization.

Table 1–3  Assortment Rationalization

Workflow Tab Worksheet Task

Identify 
Placeholders

Describe Placeholders ■ Describe placeholder items.

Brand Analysis Review / Rank Brand 
Performance

■ Assess item brand performance.

■ Review financial planning targets.

Brand Rank (Brand) ■ Assign ordering rank to brands.

Brand Rank (SKU) ■ Review calculated brand rank.

■ Enter brand rank notes.

Feature Analysis Feature Weight ■ Assign weighted rank to features.

Review / Rank Item 
Features

■ Review performance by feature.

Feature Rank ■ Review calculated feature ranking.

■ Enter feature notes.

Performance 
Analysis

Review / Rank Item 
Performance

■ Review item performance.

■ Enter performance notes.

Net Margin Analysis Review Net Margin 
Components by Item

■ Review net margin components.

■ Review item net margin performance.

■ Enter net margin performance notes.

Item Scorecard Overall Rank ■ Assign weighted ranking to each 
assessment category.

Assign Item Role and 
Type

■ Review item overall ranking.

■ Assign item role.

■ Indicate de-listed items.

■ Indicate item mandatory status.

■ Enter scorecard notes.
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Assortment Optimization
The following table contains the workflow tab, worksheets, and tasks for macro 
optimization.

Table 1–4  Assortment Optimization

Workflow Tab Worksheet Task

Identify 
Placeholders

Describe Placeholders ■ Describe placeholder items.

Determine Optimal 
Space / Profit

Define Unit Of Measure ■ Select item unit of measure, planogram 
unit of measure, step size unit of 
measure, and category tolerance unit of 
measure from drop down list.

Collection Constraints ■ Indicate mandatory status of collection 
items.

■ Indicate include status of collection items.

Optimization 
Constraints

■ Select planogram options from drop 
down list provided.

■ Enter number of shelves, constraint type, 
sub-category tolerance, step size 
tolerance, category tolerance.

■ Enable optimize measure to run 
optimization routine.

Optimize Space and 
Profit

■ View item role and de-listed items.

■ Check mandatory status.

■ Indicate include status of item.

■ Review item demand.

■ Review and adjust item retail.

■ Select item presentation standard.

■ Enter minimum and maximum number 
of facings, lead time, minimum presence, 
and safety stock multiplier.

■ Review cluster level optimization results.

■ Enable data send to space planning.

■ Review space planning 
recommendations.

■ Re-optimize as necessary.

Review Store 
Results

Review Store Results ■ Review by store space recommendations 
from item planning process.

■ Enter store level data if re-optimization is 
required.

■ Enable send data now measure to send 
store level data to space planning.

Optimize ■ Enable optimize measure to re-optimize.
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About Measures
There are four components used in constructing measures. When concatenated 
together, all four classifications become known as a single measure. It is optional 
whether all of the components are visible in the measure label. The four components 
(in order of measure label sequence) for a measure are as follows:

■ Role

■ Version

■ Metric

■ Units of Measure

Roles
Roles are typically defined by your role as a user of the Category Management 
solution. These roles typically align with the organizational structure.

■ Executive (AEx)

■ Manager (AMg)

■ Planner (APl)

■ KeyPlan Planner (KPl)

■ TopPlan Planner (TPl)

Versions
Versions are used to provide separate views to measures, which mean the same, but 
may have separate sources or timeframes. An example of a version is last year (Ly). 
Sales for this year (Wp) and last year (Ly) are intended to be compared as the same 
measure, but they need to be distinguished from one another. In order to do so, Sales 
for this year are labeled as Wp Sales, while sales for last year are labeled as Ly Sales.

The versions found in Category Management are:

■ Wp (Working plan, also known as this year)

■ Ly (Last year)

■ Fcst (Forecast)

■ Opt (Optimal)

■ Adm (Administrative)

Metrics
Metrics are used to describe what is being viewed or calculated. There are several 
metrics used in Category Management. They are identified throughout this user guide. 
Some of the key metrics found in Category Management are:

■ Sales

■ Average inventory

■ Gross margin

■ Net margin

■ GMROI
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Units of Measure
Units of measure serve to further define a metric. Examples of Category Management 
units of measure and their meaning are found in the table below.

Using the information above, here are a couple of examples of measure labels:

APl Wp Sales U = Assort Planner working plan unit sales

APl Ly Sales C = Assort Planner last year sales at cost

Table 1–5  Units of Measure

Unit of Measure Labels Unit of Measure Description

Ac Average unit cost

Ar Average unit retail

B Boolean (True / False)

C Cost value

Cp Cost percent

R Retail value

Rp Retail percent

Sl Select

Tx Text

U Units

U Unit percent

X No units

Xp No units percent
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2
Macro Rationalization

The assessment of sub-category and above performance takes place inside the Macro 
Rationalization process step. To begin, workbooks must be built using wizard steps to 
establish the content of the workbook. Product, competitor, location, timeframe, and 
consumer segment boundaries are defined in the workbook build using wizards.

Create Macro Rationalization Workbook
1. On the Category Management menu bar, select New in the File menu or click New 

on the toolbar. The New window is displayed.

Figure 2–1 New Dialog Box

2. On the Category Management tab, select Macro Rationalization and click OK. 
The Macro Rationalization Wizard opens. Using this wizard, you define several 
important plan parameters.
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3. Define products to be assessed.

Figure 2–2 Macro Rationalization Wizard - First Page

a. Select the products to be assessed.

b. Click Next. The define competitors page is displayed.
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4. Define competitors to be assessed.

Figure 2–3 Macro Rationalization Wizard - Second Page

a. Select the appropriate competitors to be assessed.

b. Click Next. The define location page is displayed.
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5. Define locations to be assessed.

Figure 2–4 Macro Rationalization Wizard - Third Page

a. Select the appropriate locations to be assessed.

b. Click Next. The define time frame page is displayed.
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6. Define time frame to be assessed.

Figure 2–5 Macro Rationalization Wizard - Third Fourth

a. Select the time frame to be assessed.

b. Click Next. The consumer segment page is displayed.
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7. Define consumer segments to be assessed.

Figure 2–6 Macro Rationalization Wizard - Final Page

a. Select the consumer segments to be assessed.

b. Click Finish. The workbook build begins. This process may take several 
minutes. 
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Macro Rationalization Workflow Tabs
The workflow tabs for macro rationalization are as follows: 

Table 2–1  Macro Rationalization Workflow Tabs

Process Step Tab Descriptions

Consumer Analysis The Consumer Analysis tab provides a view to data on the 
purchasing habits of consumer segments. The consumer 
segments available for assessment are those defined in the 
workbook build wizard steps. A text field is provided for 
entering diary notes regarding your assessment.

Competitive Intelligence The Competitive Intelligence tab provides a view to market 
share data. The competitors available for comparison are those 
defined in the workbook build wizard steps. A text field is 
provided for you to enter diary notes regarding your market 
share assessment.

Category Analysis The Category Analysis tab provides a worksheet summarizing 
the performance of categories through key performance 
measures. The products and the time frame assessed are defined 
in the workbook build wizard steps. A text field is provided for 
entering diary notes on your category assessment.

Net Margin Analysis The Net Margin Analysis tab provides a view to the measures 
used in deriving the net margin of a category. A text field is 
provided for entering diary notes on your category net margin 
assessment.

Vendor Analysis The Vendor Analysis tab provides a worksheet summarizing the 
performance through key performance measures of vendors 
within categories. A text field is provided for entering diary 
notes.

Vendor Net Margin 
Analysis

The Vendor Net Margin Analysis tab provides a view to the 
measures used in deriving, through vendor contribution, the net 
margin of a category. A text field is provided for entering diary 
notes regarding your vendor net margin contribution 
assessment.

Category Scorecard The Category Scorecard tab provides the location for assigning 
roles to categories, keeping or de-listing categories, and noting 
whether the categories are mandatory or not in the space 
optimization process to follow. A text field is provided for 
entering diary notes. 
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Consumer Analysis
In the Review Consumer Data worksheet, you review key data points that provide 
information about consumer spending.

Review Consumer Data
1. Click the Consumer Analysis workflow tab. The Review Consumer Data 

worksheet is displayed.

Figure 2–7 Review Consumer Data Worksheet

2. Review Consumer data.

3. Enter diary notes into Consumer Notes field.

4. Click Calculate. This applies the text information.

5. Save the workbook.

Note: Some of the measure fields are colored differently. This 
indicates the read-only fields from those that are editable. 

Table 2–2  Review Consumer Data Worksheet Measures

Measure Description

Consumer Seg. Name Descriptive label attached to the consumer segment name.

Store Visits / Yr Total number of store visits per year for the consumer segment.

Avg. Store Visit Average number of visits per year for each customer within the 
consumer segment.

Avg. Spend Average spend per visit.

Spend Total spend (revenue) of the consumer segment .

Ave. GM Gross margin.

Consumer Notes Text field for entering consumer analysis observations.
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Competitive Intelligence
The Review Competitive Data worksheet provides market share information by 
competitor for comparison to your market share.

Review Competitive Data
1. Click the Competitive Intelligence workflow tab. The Review Competitive Data 

worksheet is displayed. 

Figure 2–8 Review Competitive Data Worksheet

2. Review competitive data.

3. Enter diary notes into the Competitor Notes text field.

4. Click Calculate. This applies the text information. 

Note: Italics indicate that a calculation or acceptance of the new 
entry is pending. This is true in all planning steps. 

Table 2–3  Review Competitive Data Worksheet Measures

Measure Description

Brand Count Number of brands carried by each competitor.

Competitor Notes Text field for entering competitive analysis observations.

GM Gross margin.

Industry Trend Percentage of industry market share captured by each 
competitor.

MS Avg Inv Market share average inventory.

MS GM Market share gross margin.

MS GMROI Market share gross margin return on investment.

MS NM Market share net margin.

MS Sales market share sales.

MS Sales per item Market share average sales per item.

MS Sales R var LY Market share retail sales expressed as a variance to last year's 
market share retail sales.

MS Sales U var Ly Market share unit sales expressed as a variance to last year's 
market share unit sales.
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Category Analysis
The Review Category Performance worksheet provides a view to category 
performance. Performance assessment is accomplished through the use of key 
performance indicator measures.

Review Category Performance
1. Click the Category Analysis workflow tab. The Review Category Performance 

worksheet is displayed. 

2. Select Save on the toolbar to save the information.

Figure 2–9 Review Competitive Performance Worksheet

3. Review forecasted unit demand.

4. Review key financial and space performance indictor measures.

MS Sales c Prd Marker share sales expressed as a percent contribution to 
positions of the product hierarchy.

MS SKU Count Market share SKU count for each competitor.

MS TO Market share inventory turnover.

Note: Performance may be assessed using different positions of the 
location and time hierarchies. To take advantage of these many views, 
right-click while focused on the time or location hierarchy positions 
on the worksheet. Choose Select roll-up and the desired view. 

To assess this year's performance against last year's performance, 
compare the Wp (working plan) version measures against the Ly (last 
year) version measures.

Table 2–3 (Cont.) Review Competitive Data Worksheet Measures

Measure Description
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5. Enter diary notes into the performance notes text field.

6. Click Calculate. This initiates any calculations and applies the text information.

7. Select Save on the toolbar to retain all information.

Note: To conduct what-if scenarios, enter values in the Sales R and 
Space measures to view adjusted Return on Space.

Table 2–4  Review Category Performance Worksheet

Measure Description

Avg Inv Average inventory.

Current Space Current space for each category at the assessment.

Current Space c Prd Each product categories percentage contribution to the total 
space.

Demand Forecasted unit demand.

GM Gross margin.

GMROI Gross margin return on investment.

NM Net margin.

Performance Notes Text field for entering category performance observations.

Retn. on Curr. Space Return on current space.

Retn. on Space Return on planned (working plan) space.

Sales Sales.

Sales c. Prd Each product categories percentage contribution to sales.

Space Planned (working plan) space.

Space c. Prd Each product categories percentage contribution to planned 
space.

TO Inventory turn over.
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Net Margin Analysis
The Review Net Margin Performance worksheet provides a view to category net 
margin performance. Performance assessment is accomplished through the use of key 
net margin contributing performance indicator measures.

Review Net Margin Components
1. Click the Net Margin Analysis workflow tab. The Review Net Margin 

Components worksheet is displayed.

Figure 2–10 Review Net Margin Components Worksheet

2. Review net margin components and resulting net margin.

3. Edit components for what-if scenarios.

4. Enter diary notes in the NM notes text field.

5. Click Calculate. This applies and initiates any calculations, and it applies the text 
information.

6. Select Save on the toolbar to retain all information. 

Table 2–5  Review Net Margin Performance Worksheet Measures

Measure Description

Vndr Rev Allow Vendor revenue allowance.

Sales Sales.

Promo Sales Promotional sales (temporary price reductions).

Payment Terms Payment terms on invoices.

NM Notes Net margin notes.

NM Net margin.

Markdown Allowance Markdown allowances.

Markdown Markdown.

GM Gross margin.

Freight Freight costs.

Cost of Funds Cost of funds.

Carrying Costs Carrying costs.
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Vendor Analysis
The Review Vendor Performance worksheet provides a view to vendor performance 
by category. Performance assessment is accomplished through the use of key 
performance indicator measures. This view is essentially the same as the Review 
Category Performance worksheet.

Review Vendor Performance
1. Click the Vendor Analysis workflow tab. The Review Net Margin Performance 

worksheet is displayed. 

Figure 2–11 Review Vendor Performance Worksheet

2. Review forecasted unit demand by vendor.

3. Review key financial and space performance indictor measures.

4. Enter diary notes into the Performance Notes text field.

5. Click Calculate. This applies the text information.

6. Select Save on the toolbar to save all information. 

Note: To view performance by vendor, make sure that the product 
tile is placed in the upper right hand corner with the Vendor position 
selected. 

Table 2–6  Review Vendor Performance Worksheet Measures

Measure Description

Avg Inv Average inventory.

Current Space Current space for each category at the assessment.

Current Space c Prd Each product categories percentage contribution to the total 
space.

Demand Forecasted unit demand.

GM Gross margin.

GMROI Gross margin return on investment.

NM Net margin.

Performance Notes Text field for entering category performance observations.
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Vendor Net Margin Analysis
The Review Net Margin Components by Vendor worksheet provides a view to vendor 
category net margin performance. Performance assessment is accomplished through 
the use of key net margin contributing performance indicator measures. This view is 
essentially the same as the Review Net Margin Components by category worksheet.

Review Net Margin Components by Vendor
1. Click the Net Margin Analysis workflow tab. The Review Net Margin 

Performance worksheet is displayed. 

Figure 2–12 Review Net Margin Components Worksheet

2. Review net margin components by vendor and resulting net margin.

3. Edit the Wp version components for what-if scenarios.

4. Enter diary notes in the Vndr NM Notes text field.

5. Click Calculate. This initiates any what-if calculations and applies the text 
information.

6. Select Save on the toolbar to retain all information. 

Retn. on Curr. Space Return on current space.

Retn. on Space Return on planned (working plan) space.

Sales Sales.

Sales c. Prd Each product categories percentage contribution to sales.

Space Planned (working plan) space.

Space c. Prd Each product categories percentage contribution to planned 
space.

TO Inventory turn over.

Table 2–7  Review Net Margin Components by Vendor Worksheet Measures

Measure Description

Vndr Rev Allow Vendor revenue allowance.

Table 2–6 (Cont.) Review Vendor Performance Worksheet Measures

Measure Description
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Category Scorecard
 The Assign Role / Type worksheet provides the view for assigning roles to categories, 
keeping or de-listing categories, and noting whether the categories are mandatory or 
not in the space optimization process to follow. All of the assessments conducted on 
prior tabs provide the decision support used in assigning roles and types to categories.

Assign Role / Type
1. Click the Category Scorecard workflow tab. The Assign Role / Type worksheet is 

displayed. 

Figure 2–13 Assign Role/Type Worksheet

2. Assign category roles by using the drop down pick list of pre-determined options.

3. Deselect Wp Keep measure check mark to indicate the de-listing of the category. 
The category is not used in optimization process.

4. Enable the Wp Mandatory Category check box if it is mandatory for the category 
to be considered in the optimization process. 

5. Enter diary notes in the Wp Scorecard Notes text field.

6. Click Calculate to apply all decisions and text information. 

Vndr NM Notes Vendor net margin notes.

Sales Sales.

Promo Sales Promotional sales (temporary price reduction).

Payment Terms Payment terms.

NM Net margin.

Markdown Allowance Markdown allowance.

Markdown Markdown.

GM Gross margin.

Freight Freight costs.

Cost of Funds Cost of funds.

Carrying Costs Carrying costs.

Table 2–7 (Cont.) Review Net Margin Components by Vendor Worksheet Measures

Measure Description
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7. Commit and save the workbook.

Next Steps
All of the entries are complete for the Macro Rationalization step in the Category 
Management process. Proceed to the Macro Space Optimization workbook, described 
in the next chapter.

Table 2–8  Apply Role/Type Worksheet Measures

Measure Description

Scorecard Notes Text field for diary entries regarding score carding process.

Mandatory Category Check box for indicating if it is mandatory that a category 
should be included in the optimization process.

Category Role Drop down list of item role options.

Keep Check box indicating the keep or de-list status of a category.
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3
Macro Space Optimization

Macro Space Optimization occurs on two levels of the organizational hierarchy. The 
first level is typically at the department level and above. The second is sub-category to 
department level. Each level is distinguished from the other through the assignment of 
roles (Executive at the highest level and Manager at the level below) and through 
separate workbooks. The processes and metrics in each workbook are the same. The 
measures are distinguished by role with AEx (Assort Executive) in the Macro Space 
Optimization EX workbook and AMg (Assort Manager) in the Macro Space 
Optimization workbook.

For the purposes of this documentation, both the Macro Space Optimization EX 
workbook and Macro Space Optimization workbook are detailed in this chapter.

Note: The Executive User is thought to be most interested in the 
allocation of square footage. The Manager role is typically concerned 
with the base linear footage derived in collaboration with space 
planning organization. For the purposes of optimization, there is no 
understanding of square or base linear footage. The space measure 
used in the optimization routine recognizes the number numeric value 
entered, not its intent.
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Create Macro Space Optimization Workbook
1. On the Category Management menu bar, select New in the File menu or click New 

on the toolbar. The New window is displayed. 

Figure 3–1 New Dialog Box

2. On the Category Management tab, select Macro Space Optimization and click OK. 
The Macro Space Optimization Wizard opens. Using this wizard, you define 
several important plan parameters.
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3. Define products to be optimized.

Figure 3–2 Macro Optimization Ex Wizard - First Page

a. Select the products to be optimized.

b. Click Next. The define location page is displayed.
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4. Define the locations to be optimized.

Figure 3–3 Macro Optimization Ex Wizard - Second Page

a. Select the appropriate locations to be optimized.

b. Click Next. The define timeframe page is displayed.
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5. Define time frame to be optimized.

Figure 3–4 Macro Optimization Ex Wizard - Final Page

a. Select the time frame to be assessed.

b. Click Finish. The workbook build begins. This process may take several 
minutes. Once completed, the workbook opens to the first window in the first 
process step. The workflow tabs are used in order from left to right as you go 
through the macro space optimization steps.

Macro Space Optimization Workflow Tabs
The workflow tabs for macro rationalization are as follows: 

Table 3–1  Macro Space Optimization Workflow

Process Step Tab Description

Determine Optimal Space / 
Profit

The Determine Optimal Space / Profit tab provides the ability 
to manipulate optimization constraints, view, and assess the 
results of the optimization routine. The results of this process 
step are viewed at aggregated levels, such as store cluster and 
phase. 

Review Store Results The Review Store Results tab provides a store level view of the 
optimization routine, which is produced in the first step of the 
process. If desired, individual stores may be re-optimized in this 
view.
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Determine Optimal Space / Profit
Identification of constraints and macro space optimization takes place on the 
worksheets that are found under the Determine Optimal Space / Profit workflow tab. 
An additional worksheet is provided that supplies a visual representation of the space 
to profit relationship data points. The worksheet procedures are described below. 

Optimization Constraints
1. On the Macro Space Optimization workflow tabs, select Determine Space / Profit. 

Select the Optimization Constraints worksheet. 

Figure 3–5 Optimization Constraints Worksheet

2. Select the constraint type from the drop down list provided.

3. Enter the maximum space available for optimization.

4. Select Calculate to apply data entered.

5. Select Save to retain the data.

Note: The Optimize check box measure is not used until all 
optimization information is provided in the step below.

Table 3–2  Optimization Constraints Worksheet Measures

Measure Description

Constraint Type Constraint type is a single select drop down list that consists of 
two options:

■ Choosing less than or equal to produces the highest profit 
recommendation, which is based on using less space than 
or equal to the space constraint. 

■ Choosing exactly equal to forces the optimization routine 
to choose the highest profit using the exact amount of space 
provided by the constraint.

Maximum Capacity The maximum space available to be allocated. 

Optimize Check box measure that must be initialized to produce 
optimization results. 
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Optimize Space and Profit
1. Move to the window option on the toolbar and select the Optimize Space and 

Profit worksheet. 

Figure 3–6 Optimize Space and Profit Worksheet

a. Review Category Role as designated in the Macro Rationalization workbook.

b. Enable Include check box measure if the category should be included in the 
optimization routine.

c. Review the Keep measure as designated in the Macro Rationalization 
workbook.

d. Review the Mandatory Category check box measure as designated in the 
Macro Rationalization workbook.

e. Review Current Space measure.

f. Review Current GM R measure.

g. Review Space recommendation from visual store planning application.

h. Enter a numeric value into the Min. Space measure.

i. Enter a numeric value into the Max. Space measure.

2. Select Calculate to apply inputs.

3. Return to the Optimization Constraints Worksheet. Enable the Optimize check box 
and select Calculate to apply.

4. Click History Mapping Menu in the toolbar, and select Optimize from the drop 
down options to begin the optimization routine.

5. Return to the Optimal Space and Profit worksheet.

a. Review optimized results Expected Profit R measure.

b. Review optimized results Recommended Space measure.

c. Review Space Chg. Measure.
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d. Compare the Expected Profit R measure to the GM R target from the financial 
planning process.

e. Review / adjust optimization inputs as needed.

f. Select Calculate to apply changes.

6. Return to the Optimization Constraints worksheet. Enable the Optimize check 
box, and select Calculate to apply. 

7. Click the Macro Optimization Menu and select Optimize from the drop down 
options to re-initialize the optimization routine.

a. Review the adjusted space recommendations in the RVSP Space measure.

b. Enter the space planning recommendation into the Min. Space and the Max. 
Space measures to accept the space planning recommendation.

c. Repeat the optimization steps outlined above.

8. Select Save to retain the information.

Table 3–3  Optimize Space and Profit Worksheet Measures

Measure Description

Category Role Strategic role assigned to categories in the Macro 
Rationalization process.

Include Check box measure that indicates whether the category should 
be included in the optimization routine .

Keep Check box measure from Macro Rationalization process step 
that indicates the keep or de-list status of a category.

Mandatory Category Check box measure that indicates if it is mandatory that space is 
recommended for the category.

Current Space Current space that the category occupies at the time of the 
optimization activity.

Current GM Current gross margin of the category resulting from the current 
space.

Min. Space Minimum amount of space allowed to be recommended.

Max. Space Maximum amount of space allowed to be recommended.

Expected Profit Expected profit resulting from the optimization routine.

Recommended Space Recommended space resulting from the optimization routine.

Space Chg. Difference between Current Space and the Recommended 
Space.

Send Data Check box used to initiate the passing of data between Category 
Management and the space planning application.

GM Target gross margin from financial planning

Space Space recommendation from the space planning application.
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Review Store Results
Reviewing store level optimization results takes place in the worksheets found under 
the Review Store Results workflow tab. Once the space planning application processes 
the initial optimal space recommendations and execution of floor layouts begins, there 
may be a need to communicate back to Category Management exceptions to the initial 
optimal recommendations. After review, you may need to re-optimize in Category 
Management. This is based on those space planning, individual store constraints.

Optimize
1. Click the Review Store Results workflow tab. 

2. Move to the window option on the toolbar and select the Optimize worksheet.

Figure 3–7 Optimize Worksheet

Note: You return to this worksheet after completing the 
pre-optimization steps on the next worksheet.

Table 3–4  Optimize Worksheet Measures

Measure Description

Optimize Check box measures that must be initiated prior to the running 
of the optimization routine.
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Review Store Results
1. Move to the window option on the toolbar and select the Review Store Results 

worksheet. 

Figure 3–8 Review Store Results Worksheet

a. Review Space measure recommendation from the visual space planning 
application.

b. Review optimized Recommended Space quantity.

c. Review optimized Expected Profit R value.

d. Review Current Space measure.

e. Review Current GM R measure.

f. Enter Space measure numeric value into the Min. Space measure to accept the 
space planning recommendation.

g. Enter Space measure numeric value into the Max. Space measure to accept the 
space planning recommendation.

2. Select Calculate to apply inputs.

3. Enable Include check box measure if the category should be included in the 
individual store optimization routine.

4. Review Keep measure as designated in the Macro Rationalization workbook.

5. Enable the Mandatory Category check box measure if it is mandatory that the 
category is allocated space in the optimization routine.

6. Select Calculate to apply inputs.

Note: To view individual store category optimization results focus 
on the location portion of the slice and, using the arrow buttons, page 
through the stores.
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7. Return to the Optimize worksheet. Enable the Optimize check box. Select 
Calculate to apply.

8. Click Macro Optimization Menu Option and select Optimize from the drop down 
options to begin the optimization routine.

a. Review optimized Recommended Space quantity.

b. Review optimized Expected Profit R value.

9. Commit and save the workbook.

Next Steps
All of the entries are complete for the Macro Space Optimization step of the Category 
Management process. Proceed to Step 3, Assortment Rationalization, described in the 
next chapter.

 

Table 3–5  Review Store Results Worksheet Measures

Measures Description

Category Role Strategic role assigned to categories in the Macro 
Rationalization process.

Include Check box measure that indicates whether the category should 
be included in the optimization routine.

Keep Check box measure from Macro Rationalization process step 
that indicates the keep or de-list status of a category.

Mandatory Category Check box measure that indicates if it is mandatory that space 
be recommended for the category.

Current Space Current space that the category occupies at the time of the 
optimization activity.

Current GM Current gross margin of the category resulting from the current 
space.

Min. Space Minimum amount of space allowed to be recommended.

Max. Space Maximum amount of space allowed to be recommended.

Expected Profit Expected profit resulting from the optimization routine.

Recommended Space Recommended space resulting from the optimization routine.

Space Chg. Difference between the Current Space and the Recommended 
Space.

Send Data Check box used to initiate the passing of data between Category 
Management and the space planning application.

GM Target gross margin from financial planning.

Space Space recommendation from the space planning application.
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4
Assortment Rationalization

The assessment of item performance and item relevance within the product mix takes 
place inside the assortment rationalization process step. As in the prior steps, 
workbooks must be built using wizard steps to establish the content of the workbook. 
Product, feature, location, and time hierarchies are defined in the workbook build 
using wizards.

Create Assortment Rationalization Workbook
1. On the Category Management menu bar, select New from the File menu or click 

New on the toolbar. The New window is displayed.

Figure 4–1 New Dialog Box

2. On the Category Management tab, select Assortment Rationalization and click 
OK. The Assortment Rationalization wizard opens. 
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3. Define products to be assessed.

Figure 4–2 Assortment Rationalization Wizard - First Page

a. Select the products to be assessed.

b. Click Next. The define item features page is displayed.
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4. Define item features to be assessed.

Figure 4–3 Assortment Rationalization Wizard - Second Page

a. Select the appropriate item features to be assessed.

b. Click Next. The define location page is displayed.
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5. Define locations to be assessed.

Figure 4–4 Assortment Rationalization Wizard - Third Page

a. Select the appropriate locations to be assessed.

b. Click Next. The define timeframe page is displayed.
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6. Define time frame to be assessed.

Figure 4–5 Assortment Rationalization Wizard - Final Page

a. Select the time frame to be assessed.

b. Click Finish. The workbook build begins. This process may take several 
minutes. Once completed, the workbook opens to the first window in the first 
process step. The workflow tabs are used in order from left to right as you go 
through the assortment rationalization steps.
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Assortment Rationalization Workflow Tabs
The assortment rationalization workflow tabs are located below the Category 
Management toolbar and are used to move between sets of windows displaying the 
process steps used in assortment rationalization. You can either click the workflow 
tabs or use Next and Previous on the toolbar to move between them. The workflow 
tabs for assortment rationalization are as follows:

Table 4–1  Assortment Rationalization Workflow Tabs

Process Step Tab Descriptions

Identify Placeholders When placeholder items are added to the assortment mix, they 
are described (labeled) using the worksheet provided on the 
Identify Placeholders tab.

Brand Analysis The Brand Analysis tab provides:

■ A view to item performance by brand.

■ The ability for you to assign an importance ranking to each 
brand.

■ A calculated brand ranking .

Feature Analysis The Feature Analysis tab provides the ability to weight 
importance of pre-defined features in order to calculate a 
feature ranking.

Performance Analysis The Performance Analysis tab provides a view facilitating 
financial performance analysis. Financial and item planning 
targets are provided.

Net Margin Analysis The Net Margin Analysis tab provides an assessment view to 
the net margin components for each item.

Item Scorecard Items are ranked and roles are assigned using worksheets on the 
Item Scorecard tab. 
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Identify Placeholders
 Identification of placeholder items while in the assortment rationalization process 
takes place on the Describe Placeholders worksheet found by accessing the Identify 
Placeholders tab in the workflow process. 

Describe Placeholders
1. On the Assortment Rationalization workflow tabs, select Identify Placeholders. 

The Describe Placeholders worksheet appears. 

Figure 4–6 Describe Placeholders Worksheet

2. Enter Placeholder description into the Item Description measure.

3. Select Calculate to apply descriptions.

4. Select Save to save the data.

Note: If placeholder functionality is not required, this step may be 
skipped. If skipped, begin the workflow at the Brand Analysis tab.

Table 4–2  Describe Placeholders Worksheet Measures

Measure Description

Item Description User provided label used to describe a placeholder item.
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Brand Analysis
Analysis of item performance on the Brand Analysis workflow tab is supported by 
three worksheets. Overall SKU by brand performance is viewed on the Review / Rank 
Brand Performance worksheet. The Brand Rank (Brand) worksheet is used for 
assigning ranks to brands found within the assortment mix. The Brand Rank (SKU) 
worksheet where the brand rank by SKU is calculated and text notes are added.

Review / Rank Brand Performance
1. Move to the window option on the toolbar and select the Review / Rank Brand 

Performance worksheet. 

Figure 4–7 Review/Rank Brand Performance Worksheet

2. Review item by brand forecasted item demand.

3. Review item by brand performance assessment measures; such as sales, gross 
margin, net margin, GMROI, and average inventory.

4. Compare current item by brand performance with last year's performance using 
assessment measures; such as sales, gross margin, net margin, GMROI, and 
average inventory.

5. Compare item performance by brand against key item targets (if available).

6. Review aggregated item performance against financial targets (if available).

Table 4–3  Review/Rank Brand Performance Worksheet Measures

Measure Description

TO Inventory turn over.

Sales var Ly Sales variance to last year expressed as a percentage.

Sales Sales.

NM Net margin.

GMROI Gross margin return on investment.

GM Gross margin.

Demand Forecasted unit demand.

Avg Inv Average inventory.

% Cont. Sales Child sales contribution to parent sales expressed as a 
percentage.



Assortment Rationalization Workflow Tabs

Assortment Rationalization 4-9

Brand Rank (Brand)
1. Move to the window option on the toolbar and select the Brand Rank (Brand) 

worksheet. 

Figure 4–8 Brand Rank (Brand) Worksheet

2. Enter 1 to 3 ranking for each brand with 1 being assigned to the best performing 
brands and 3 the least in performance.

3. Select Calculate to apply the rankings.

4. Select Save to retain the information.

Note: The rankings assigned to brands are used in calculating the 
overall item rank used in the keep / de-list decision making the end of 
the assortment rationalization process.

Table 4–4  Brand Rank (Brand) Worksheet Measure

Measure Description

Brand Rank By Brand Ranking from 1 to 3 of brand performance.
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Brand Rank (SKU)
1. Move to the window option on the toolbar, and select the Brand rank (Brand) 

worksheet. 

Figure 4–9 Brand Rank (Sku) Worksheet

2. Sort SKUs by brand ranking. SKUs with the highest ranking are ranked with a 1.

3. Enter comments into Brand Notes text measure provided.

4. Select Calculate to apply the text information.

5. Select Save to retain the information.

Feature Analysis
 The analysis of item by feature performance on the Feature Analysis workflow tab is 
supported by three worksheets. 

■ Feature Weight - This worksheet used in the feature rank calculation, is 
determined on the Feature Weight worksheet. 

■ Feature Rank - This worksheet contains the final feature ranking and the Notes 
field to enter comments. 

■ Review / Rank Item Features (Optional) - This worksheet provides the item 
performance measures for review. 

Table 4–5  Brand Rank (SKU) Worksheet Measures

Measure Description

Brand Rank by SKU Item by brand ranking assignment reflecting previously 
assigned brand rank.

Brand Notes Text field for entering item by brand rank observations.
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Feature Weight 
1. Move to the window option on the toolbar, and select the Feature Weight 

worksheet. 

Figure 4–10 Feature Weight Worksheet

2. Review feature categories and criteria listed as important in the categories.

3. Enter the desired weight of each feature. This weight is used in the final item by 
feature ranking.

4. Select Calculate to apply the category weight assignments.

Note: Categories are updated by way of scheduled batch routines 
that update the feature hierarchy. The feature criteria are managed 
administratively. See Administration section.

Note: The sum of all the categories weights must equal 1.

Table 4–6  Feature Weight Worksheet Measures

Measure Description

Feature Criteria Category attributes that are recognized as being important in 
evaluating items by feature.

Feature Weight Weight assigned to each feature category.
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Feature Rank
1. Move to the window option on the toolbar, and select the Feature Rank worksheet. 

Figure 4–11 Feature Rank Worksheet

2. Sort the product hierarchy by using the Feature Rank measure.

3. Review item by feature ranking.

4. Enter observations in the Features Notes text field.

5. Click Save to apply entered information.

Note: For sorting instructions, refer to the Brand Analysis process 
step section, Brand Rank (SKU) worksheet.

Table 4–7  Feature Rank Worksheet Measures

Measure Description

Feature Rank Item by feature calculated ranking assignment using assigned 
feature weight and Administratively assigned feature 
thresholds.

Feature Notes Text field for entering item by brand rank observations.
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Review / Rank Item Features (Optional)

1. Move to the window option on the toolbar and select the Review / Rank Item 
Features worksheet. 

Figure 4–12 Review/Rank Item Features Worksheet

2. Review item forecasted item demand.

3. Review item performance assessment measures; such as sales, gross margin, net 
margin, GMROI, and average inventory.

4. Compare current item performance with last year's performance using assessment 
measures; such as sales, gross margin, net margin, GMROI and average inventory.

5. Compare item performance against key item targets (if available).

6. Review aggregated item performance against financial targets (if available).

Note: The Review / Rank Item Features worksheet is optional: it is a 
duplicate view of the Performance Analysis and Net Margin Analysis 
workflow tabs.

Table 4–8  Review/Rank Item Features Worksheet Measures

Measures Description

TO Inventory turn over.

Sales var Ly Sales variance to last year expressed as a percentage.

Sales Sales.

NM Net margin.

GMROI Gross margin return on investment.

GM Gross margin.

Demand Forecasted unit demand.

Ave Inv Average inventory.

% Cont. SalesChild sales contribution to parent sales expressed as a 
percentage.
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Performance Analysis
 The analysis of item gross margin performance on the Performance Analysis 
workflow tab is supported by the Review / Rank Item Performance worksheet. The 
purpose of the Review / Rank Item Performance worksheet is to provide a view to all 
of the measures that are needed to accurately assess the gross margin performance of 
an item. The role that the item plays within the product mix towards achieving the 
financial goals of the total category is also assessed. The role of the category as 
determined in the Macro Rationalization process is visible. Targets from item planning 
and financial planning are also support available to support this process step.

Review / Rank Item Performance 
1. On the Assortment Rationalization workflow tabs, select Performance Analysis. 

The Review / Rank Item Performance worksheet appears. 

Figure 4–13 Review/Rank Item Performance Worksheet

2. Review Category Role measure from Macro Rationalization.

3. Review Mandatory Category measure for category status.

4. Review Demand measure for the forecasted demand.

5. Review key assessment measures; such as sales, average inventory, inventory turn 
over and gross margin.

6. Sort products using the GM Rp measure to view items in order of gross margin % 
contribution.

7. Compare performance against last year's financial and key item targets.

8. Enter observations into the Performance Notes text measure.

9. Select Calculate to apply the information.

10. Select Save to retain the information.

Table 4–9  Review/Rank Item Performance Worksheet Measures

Measure Description

TO Inventory turn over.

Sales var Ly Sales variance to last year expressed as a percentage.

Sales Sales.
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Net Margin Analysis
The analysis of the net margin components by item on the Net Margin Analysis 
workflow tab is supported by the Review Net Margin Components by Item worksheet. 
The purpose of the Review Net Margin Components by Item worksheet is to provide a 
vehicle for reviewing the individual net margin components at the item level. The net 
margin percent provides the metric used in calculating the item performance ranking 
used in the score carding process step.

Review Net Margin Components by Item
1. On the Assortment Rationalization workflow tabs, select Net Margin Analysis. 

The Review Net Margin Components by Item worksheet appears. 

Figure 4–14 Review Net Margin Components by Item Worksheet

2. Review the GM R value measure.

3. Review the individual net margin components measures.

4. Compare the net margin components against last year's item planning targets and 
financial aggregate targets.

5. Review net margin measures.

6. Review the calculated item performance ranking.

7. Sort items using the Performance Rank measure.

NM Net margin.

GMROI Gross margin return on investment.

GM Gross margin.

Demand Forecasted unit demand.

Ave Inv Average inventory.

% Cont. Sales Child sales contribution to parent sales expressed as a 
percentage.

Performance Rank Calculated performance rank.

Performance Notes Text field for entering item performance observations.

Table 4–9 (Cont.) Review/Rank Item Performance Worksheet Measures

Measure Description
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8. Enter observations into the Performance Notes text measure.

9. Select Calculate to apply the information.

10. Select Save to retain the information.

Item Scorecard
Assortment rationalization is complete once items are assigned roles and types. This 
activity is accomplished on the Item Scorecard workflow tab. There are two 
worksheets supporting the final task. The first is the Overall Rank worksheet where 
the relative importance of brand, feature, and performance is weighted. The second is 
the Assign Item Role and Type worksheet. Here the overall calculated item rank is 
reviewed, each item is assigned a role, and the decision to keep or de-list an item is 
made. In addition, an item's mandatory status and scorecard notes are added.

Overall Rank
1. On the Assortment Rationalization workflow tabs, select Item Scorecard. Move to 

the window option on the toolbar and select the Overall Rank worksheet. 

Figure 4–15 Overall Rank Worksheet

2. Assign a relative to importance weight to the brand, feature, and performance 
analysis steps. This weight is used in calculating the final rank of an item. The 
weight must sum to 1.

Table 4–10  Review Net Margin Components by Item Worksheet Measures

Measure Description

Vndr Rev Allow Vendor revenue allowance.

Sales Sales.

Promo Sales Promotional sales (temporary price reductions).

Payment Terms Payment terms on invoices.

NM Notes Net margin notes.

NM Net margin.

Markdown Allowance Markdown allowances.

Markdown Markdowns.

GM Gross margin.

Freight Freight costs.

Cost of Funds Cost of funds.

Carrying Costs Carrying costs.
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3. Select Calculate to apply the data just entered.

Assign Item Role and Type
1. Move to the window option on the toolbar and select the Assign Item Role and 

Type worksheet. 

Figure 4–16 Assign Item Role and Type Worksheet

2. Review calculated overall rank measure.

3. Review calculated overall weight measure.

4. Assign Item Role using the drop down list of available options.

5. Assign list, de-list status of the item using the Keep check box measure.

6. Assign item type for assortment optimization status using the Mandatory Item 
check box measure.

7. Enter Scorecard Notes in the text field provided.

8. Select Calculate to apply the data entered.

9. Save and commit the workbook.

Table 4–11  Overall Rank Worksheet Measures

Measures Description

Brand Overall Weight Weight expressed as a percentage and assigned to represent the 
importance of brand in evaluating an item.

Feature Overall Weight Weight expressed as a percentage and assigned to represent the 
importance of features in evaluating an item.

Performance Overall 
Weight

Weight expressed as a percentage and assigned to represent the 
importance of performance in evaluating an item.

Table 4–12  Assign Item Role and Type Worksheet Measures

Measure Description

Overall Weight Calculated overall weight combining brand, feature, and 
performance thresholds and weights.

Overall Rank Calculated ranking using inputs from prior steps.
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Next Steps
All of the entries are complete for the Assortment Rationalization step of the Category 
Management process. Proceed to Step 3, Assortment Optimization, described in the 
next chapter.

Item Role Measure consisting of a drop down list of item roles.

Keep Check box measure that indicates the item is to be kept or 
de-listed.

Mandatory Item Check box measure that indicates if an item is to be considered 
mandatory as the assortment is optimized.

Scorecard Notes Text field for entering observations and action points as a result 
of the score carding process.

Table 4–12 (Cont.) Assign Item Role and Type Worksheet Measures

Measure Description
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5
Assortment Optimization

In this step of the Category Management process, category mix is optimized within the 
context of available space and profit potential. As in the prior steps, workbooks must 
be built using wizard steps to establish the content of the workbook. Product, location, 
and time hierarchies are defined in the workbook build using wizards.

Create Assortment Optimization Workbook
1. On the Category Management menu bar, select New in the File menu or click New 

on the toolbar. The New window opens.

Figure 5–1 New Dialog Box

2. On the Category Management tab, select Assortment Optimization and click OK. 
The Assortment Optimization Wizards are displayed. Using these wizards, you 
define several important plan parameters.
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3. Define the products to be optimized. Only a product with an assigned planogram 
is displayed for selection.

Figure 5–2 Assortment Optimization Wizard - First Page

a. Select the products to be optimized.

b. Click Next. The define location page is displayed.
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4. Define the locations to be optimized. Only the locations that carry the selected 
product are displayed for selection

Figure 5–3 Assortment Optimization Wizard - Second Page

a. Select the appropriate locations to be optimized.

b. Click Next. The define timeframe page is displayed.
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5. Define the time frame to be optimized. Only the time frames that carry the selected 
product at the selected stores are displayed for selection.

Figure 5–4 Assortment Optimization Wizard - Third Page

a. Select the time frame to be assessed.

b. Click Next. The define planogram page is displayed.
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6. Define the planogram to be optimized. Only planograms that have the selected 
product at the selected stores during the selected time frame are displayed for 
selection.

Figure 5–5 Assortment Optimization Wizard - Final Page

a. Select the planogram to be optimized.

b. Click Finish to begin the workbook build. This process may take several 
minutes. Once completed, the workbook opens to the first window in the first 
process step. The workflow tabs are used in order from left to right as you go 
through the assortment optimization steps.
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Menu Options
The custom menu component of the tool bar is labeled. Assortment Optimization 
produces a drop down list of user-initiated actions that take place inside of the 
Assortment Optimization workbook. They are detailed in the table below.

Assortment Optimization Workflow Tabs
The following table describes the workflow tabs for assortment optimization.

Note: The main menu options are described in detail in the online 
help (accessible from the Help menu when running Assort) and in the 
RPAS User Guide for the Classic Client.

Table 5–1  Menu Options

Action Action Description

Optimize Initiates the running of the optimization routine.

Table 5–2  Assortment Optimization Workflow Tabs

Process Step Tab Description

Identify Placeholders When placeholder items are added to the assortment mix 
during assortment optimization, they are described (labeled) 
using the worksheet that is provided on the Identify 
Placeholders tab.

Determine Optimal Space / 
Profit

The Determine Optimal Space / Profit tab provides the ability 
to manipulate optimization constraints, view, and assess the 
results of the optimization routine. The results of this process 
step are viewed at aggregated levels, such as store cluster and 
phase. 

Review Store Results The Review Store Results tab provides a store level view of the 
optimization routine produced in the first step of the process. If 
desired, individual stores may be re-optimized in this view. 
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Identify Placeholders
Identification of placeholder items while in the assortment optimization process takes 
place on the Describe Placeholders worksheet, found by accessing the Identify 
Placeholders tab in the workflow process.

Describe Placeholders
1. On the Assortment Optimization workflow tabs, select Identify Placeholders. The 

Describe Placeholders worksheet appears.

Figure 5–6 Describe Placeholders Worksheet

2. Enter a Placeholder description into the Item Description measure.

3. Select Calculate to apply descriptions.

4. Select Save to save the data.

Note: If placeholder functionality is not required, this step may be 
skipped. If skipped, the workflow starts at the Determine Optimal 
Space / Profit tab. This placeholder identification process is the same 
as that described in Assortment Rationalization and Like Item. 
Placeholders identified in Assortment Rationalization or Like Item 
appear here as already defined.

Table 5–3  Describe Placeholders Worksheet Measures

Measure Description

Item Description User provided label used to describe a placeholder item.
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Determine Optimal Space / Profit
Identification of optimization constraints and assortment optimization take place on 
worksheets found under the Determine Optimal Space / Profit workflow tab. 
Worksheets are provided to:

■ Define units of measure.

■ Enter constraints.

■ Provide a visual representation of the space-to-profit relationship data points.

An optional step of the process allows for optimization at the collection level. This 
option is used when the decision to carry items depends on the performance of several 
related items.

Define Unit of Measure
1. On the Assortment Optimization workflow tabs, select Determine Optimal 

Space/Profit. Select the Define Unit of Measure worksheet from the window drop 
down list on the Assort toolbar.

Figure 5–7 Define Unit of Measure Worksheet

2. From the drop down list, select an item unit of measure by using the item UOM 
measure.

3. From the drop down list, select a planogram shelf size unit of measure by using 
the POG UOM measure.

4. Select Calculate to apply the entries.

Table 5–4  Define Unit of Measures Worksheet Measures

Measure Description

Item UOM Drop down list of unit of measure options (inches, centimeters, 
feet) for each item .

POG UOM Drop down list of unit of measure options (inches, centimeters, 
feet, yards) for each planogram.
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Optimization Constraints
1. Select the Optimization Constraints worksheet from the window drop down list.

Figure 5–8 Optimization Constraints Worksheet

2. Select the desired Constraint Type.

3. Enter the number of shelves per planogram if not already specified in the 
Administration workbook.

4. Enter the shelf size per planogram if not already specified in the Administration 
workbook.

5. Select the desired optimization objective function metric.

6. Select the desired optimization method.

The Optimize measure is used after completing the remaining worksheets in the 
steps that follow.

7. Select Calculate to apply the data.

Note: Heuristic does not support "Exactly equal to".

Table 5–5  Define Unit of Measures Worksheet Measures

Measure Description

POG Shelf Size Single select measure with a list of appropriate shelf lengths for 
the item to be optimized.

Objective Function Mode The optimization metric. The available options are: profit, 
revenue return on space, unit return on space, gross margin 
return on space.

Optimization Method The optimization algorithm. The available options are Optimal 
and Heuristic.

Number Of Shelves Number of shelves on the planogram to be optimized.

Opt Result String The String containing optimization validation information.

Constraint Type Single select measure that specifies the constrain type. The 
available options are "less than or equal to" and "exactly equal 
to".
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Optimize Inputs
1. Select the Optimize Inputs worksheet from the window drop down list.

Figure 5–9 Optimization Inputs Worksheet

a. Review Item Role as designated in the Assortment Rationalization workbook.

b. Review and adjust item cost using the Item Cost measure.

c. Review and adjust item retail using the Item Retail measure.

d. Enter the number of weeks between reorders in the Lead Time measure.

e. Enter the weight per item. The specified weight is used to weight the item 
accordingly in the calculation of the objective function in the optimization 
routine.

2. Select Calculate to apply the optimization information.

Optimize When enabled, this check box measure initiates the optimization 
routine.

Table 5–6  Optimization Inputs Worksheet Measures

Measure Description

Item Role Strategic role assigned to items in the Assortment 
Rationalization process.

Item Cost Amount paid to the Vendor for the item.

Item Retail Full retail value of the item.

Lead Time Number of weeks between reorders.

Weight Multiplying factor for optimization metrics.

Table 5–5 (Cont.) Define Unit of Measures Worksheet Measures

Measure Description
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Optimize Space and Profit
1. Select the Optimize Space and Profit worksheet from the window drop down list.

Figure 5–10 Optimize Space and Profit Worksheet

a. Enable the Included Items check box measure if the item should be included in 
the optimization routine.

b. Review Keep measure as designated in the Assortment Rationalization 
workbook.

c. Enable the Mandatory Category check box measure if it is mandatory that the 
category is allocated space in the optimization routine.

d. Enter anticipated average selling price in the Sales Ar measures.

e. Review forecasted item demand in the Demand measure.

f. Review default item presentation standard. Change the item presentation 
standard by selecting from the drop down list of options provided in the Item 
Presentation Standard measure.

g. Review resulting new Item Depth, Item Height, Item Width, and Facing 
Capacity measurements that changed with the new item presentation.

h. Using the Min. Presence measure, enter the number of items on a shelf that 
would trigger the need to restock that shelf.

i. Review the current Gross Margin value and Gross Margin percentage 
measures.
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j. Enter the minimum number of facings for this item on this planogram (see 
Optimization Constraints worksheet described earlier in this section) in the 
Min. Facings measure.

k. Enter the maximum number of facings for this item on this planogram in the 
Max. Facings measure.

2. Select Calculate to apply the optimization information.

3. Return to the Optimize worksheet, and enable the Optimize check box. Select 
Calculate to apply.

4. Click the Assortment Optimization custom menu on the toolbar and select 
Optimize from the drop down options to begin the optimization routine.

5. Return to the Optimal Space and Profit worksheet.

a. Review the optimized number of facings in the Item Facings measure.

b. Review optimized sales information in the Sales, Sales C, and Sales R 
measures.

c. Review the anticipated gross margin value resulting from the optimization 
routine.

d. Revise optimization inputs as necessary.

6. Select Calculate to apply changes.

7. Return to the Optimize worksheet, and enable the Optimize check box. Select 
Calculate to apply.

8. Click the Assortment Optimization label on the toolbar and select Optimize from 
the drop down options to re-initialize the optimization routine.

9. Click the Send Data check box on the Optimize Space / Profit worksheet box to 
initiate the passing of data from Assort to the space planning application.

10. Select Calculate to apply the Send Data command.

11. Select Save to retain the information.

Note: You may choose to send data for selected items by checking 
the Send Data check box at the item level. 

Table 5–7  Optimize Space and Profit Worksheet Measures

Measure Description

Include Check box measure that indicates whether the item should be 
included in the optimization routine.

Keep Check box measure from Assortment Rationalization process 
step that indicates the keep or de-list status of an item.

Mandatory Item Check box measure that indicates if it is mandatory that space 
be recommended for the item.

Sales Ar Average selling price for the item.

Demand Embedded unconstrained forecasted consumer demand for the 
item.
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Review Store Results
Reviewing store level optimization results takes place in the worksheets found under 
the Review Store Results workflow tab. Once the space planning application processes 
the initial optimal space recommendations, and execution of item on fixture layouts 
begins, there may be a need to communicate back to Category Management exceptions 
driven by factual space constraints to the initial optimal recommendations. After 
review, there may be a need to re-optimize in Category Management based on those 
space planning, individual store constraints.

Optimize
1. Click the Review Store Results workflow tab.

2. Move to the window option on the toolbar, and select the Optimize worksheet.

Figure 5–11 Optimize Worksheet

Item Presentation Standard Single select drop down list of presentation options for each 
item. 

Each item is seeded with a default presentation style such as 
front or side.

Item Depth Depth of the item given the presentation standard chosen.

Item Height Height of the item given the presentation standard chosen.

Item Width Width of the item given the presentation standard chosen.

Facing Capacity Number of items behind each facing given the presentation 
standard chosen.

Min. Presence Shelf quantity that triggers the restocking of that shelf.

GM Gross margin.

Min. Facings Minimum number of facings to be considered in the 
optimization routine.

Max. Facings Maximum number of facings to be considered in the 
optimization routine.

Item Facings The number of item facings returned by the optimization 
routine between the minimum and maximum boundaries.

Sales Sales.

Send Data Check box measure that indicates which optimized items may 
be sent to the visual space planning solution.

Table 5–7 (Cont.) Optimize Space and Profit Worksheet Measures

Measure Description
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Review Inputs
1. Move to the window option on the toolbar, and select the Review Inputs 

worksheet.

Figure 5–12 Review Inputs Worksheet

a. Review item roles, cost, retail, lead time, and safety stock multiplier.

b. Roll the worksheet up to all calendar and review weight information.

2. Select Calculate to apply inputs.

Table 5–8  Optimize Worksheet Measures

Measure Description

Optimize Check box measures that must be initiated prior to the running 
of the optimization routine.

Opt Result String String output measure containing optimization validation 
message.

Table 5–9  Review Inputs Worksheet Measures

Measure Description

Item Role Strategic role assigned to items in the Assortment 
Rationalization process.

Item Cost Amount paid to the Vendor for the item.

Item Retail Full retail value of the item.

Lead Time Number of weeks between reorders.

Weight Multiplying factor for optimization metrics.
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Review Store Results
1. Move to the window option on the toolbar, and select the Review Store Results 

worksheet.

Figure 5–13 Review Store Results Worksheet

a. Review Number of Facings measure recommendation from the visual space 
planning application.

b. Review optimized Sales, Sales R, and Sales C quantities.

c. Review optimized number of facings.

d. Review optimized gross margin value.

e. To accept visual planning recommendations, enter Number of Facings 
quantity into the Min. and Max. Facings measures.

f. Enable the Include check box measure if the item is to be included in the 
individual store optimization routine.

g. Review Keep measure as designated in the Assortment Rationalization 
workbook.

Note: To view individual store item optimization results, focus on 
the location portion of the slice. Use the arrow buttons to page 
through the stores.
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h. Review the Mandatory Item check box measure as designated in the 
Assortment Rationalization workbook.

2. Select Calculate to apply inputs.

3. Return to the Optimize worksheet, and enable the Optimize check box. Select 
Calculate to apply.

4. Click Assortment Optimization label on the toolbar and select Optimize from the 
drop down options to begin the optimization routine.

a. Review optimized Item Facings measure quantity.

b. Review optimized Sales, Sales R, Sales C, and GM quantities.

5. Commit and save the workbook.

Table 5–10  Review Store Results Worksheet Measures

Measure Description

Include Check box measure that indicates whether the item should be 
included in the optimization routine.

Keep Check box measure from Assortment Rationalization process 
step that indicates the keep or de-list status of an item.

Mandatory Item Check box measure that indicates if it is mandatory that space 
be recommended for the item.

Sales Ar Average selling price for the item.

Demand Embedded unconstrained forecasted consumer demand for the 
item.

Item Presentation Standard Single select drop down list of presentation options for each 
item Each item is seeded with a default presentation style such 
as front or side.

Item Depth Depth of the item given the presentation standard chosen.

Item Height Height of the item given the presentation standard chosen.

Item Width Width of the item given the presentation standard chosen.

Facing Capacity Number of items behind each facing given the presentation 
standard chosen.

Min. Presence Shelf quantity that triggers the restocking of that shelf.

GM Gross margin.

Min. Facings Minimum number of facings to be considered in the 
optimization routine.

Max. Facings Maximum number of facings to be considered in the 
optimization routine.

Item Facings The number of item facings returned by the optimization 
routine between the minimum and maximum boundaries.

Sales Sales.

Send Data Check box measure that indicates which optimized items may 
be sent to the visual space planning solution.
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Sending and Receiving Data from Assortment Optimization to Visual Space Planning 
Tools

Users can commit results from the Assortment Optimization runs and export 
necessary measures into flat files in order to send them to external Visual Space 
planning tools.

It is possible to initialize the export of this information from within the Assortment 
Optimization workbook by configuring a custom menu to commit changes to, and 
export data from, the database. However, it is not recommended to export information 
in this manner as the possibility of multiple users performing Assortment 
Optimization may result in contention issues.

Next Steps
All of the entries are complete for the Assortment Optimization step. A number of 
facing recommendations are sent to the space planning organization for execution into 
item presentations in the stores. This can be done through a batch extraction script. 
There are several functions that support Category Management, which are found in 
the next sections.

Note: It is possible to refresh the workbook with results from 
external systems while within the workbook by using the Refresh 
Visual Planning Data custom menu.
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6
Administration

An Administrative workbook is provided for defining the corporate guidelines and 
data required in the assessment and optimization process steps. The workbook 
consists of workflow tabs and worksheets that mirror the Category Management 
workflow. Each worksheet requires the entry of corporate level data. As such, an 
Administrator or Power User would manage and maintain this workbook.

As with the other workbooks described in this document, the Administrator 
workbook must be created.

Phase definition is done from the Hierarchy Maintenance workbook under the 
Administration Tab. Phase is available as a User Defined dimension.

All other administrative parameters are set from the Administration workbook under 
the Category Management tab. 
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Building the Hierarchy Maintenance Workbook
Corporate phases are defined in the hierarchy maintenance workbook under the 
Administration tab.

1. On the Category Management menu bar, select New in the File menu or click New 
on the toolbar. The New window is displayed.

Figure 6–1 New Dialog Box

2. On the Administration tab, select Hierarchy Maintenance and click OK. The 
Hierarchy Maintenance Wizards are displayed.
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3. Select Phase dimension.

Figure 6–2 Hierarchy Maintenance Wizard - First Page
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4. Define time frame for naming phases.

Figure 6–3 Hierarchy Maintenance Wizard - Final Page

5. Click Finish. The workbook build begins. 



Define Phases

Administration 6-5

Define Phases

Figure 6–4 Week-Phase Worksheet

1. Enter phase description in the Phase Description text measure.

2. Select Calculate to apply the phase information.

3. Select Commit Now from the File menu to retain the data. Note that you are given 
the opportunity to save the workbook before committing. When finished, a 
success message appears, confirming the commit.

Note: Only one phase may be assigned to a week.

Table 6–1  Week-Phase Worksheet Measures

Measure Description

Phase Description Text field used for defining phases by week.
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Create Administration Workbook
1. On the Category Management menu bar, select New in the File menu or click New 

on the toolbar. The New window is displayed. Under the Category Management 
tab, select Administration.

Figure 6–5 New Dialog Box
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2. Select weeks for which you want to view phases.

Figure 6–6 Administration Wizard - First and Final Page

Define Phases
This worksheet displays phases defined from the Hierarchy Maintenance workbook, 
described previously. This is a read-only measure.

Figure 6–7 Define Phases Worksheet
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Macro Space Rationalization
The worksheets found under the Macro Rationalization workflow tab support the 
Competitive Analysis assessment functionality in the Macro Rationalization process 
step. The first worksheet, Define Competitors, supports the definition of corporate 
competitors. Once they are defined, these competitors appear in the Define 
Competitors wizard, and they are chosen for assessment in the workbook build 
process. The second worksheet, Market Share Information, provides the vehicle by 
which market share information by category appears in the workbooks.

Define Competitors
1. Click the Macro Rationalization workflow tab. 

Figure 6–8 Define Competitors Worksheet

2. Move to the window option on the toolbar, and select the Define Competitors 
worksheet.

3. Enter Competitor names using the Competitor Definition text measure.

4. Select Calculate to apply the information.

5. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Table 6–2  Define Competitors Worksheet Measures

Measure Description

Competitor Definition Text field used for defining competitors.
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Market Share Information
1. Click the Macro Rationalization workflow tab. 

Figure 6–9 Market Share Information Worksheet

2. Move to the window option on the toolbar, and select the Market Share 
Information worksheet.

3. Enter category level competitive information by using the key performance 
measures provided.

4. Select Calculate to apply the data.

5. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Macro and Assortment Optimization
The data and constraints required for optimization are found on the Macro and 
Assortment Optimization workflow tab. There are several worksheets that support 
this information. Planogram information used in Macro Space Optimization is applied 
on the Planogram Properties and Planogram Properties (Ex) worksheets. Store level 
optimization parameters are applied on the Store Operating Hours worksheets and the 
Store Optimization Parameters worksheets.

Table 6–3  Market Share Information Worksheet Measure

Measure Description

Brand Count The number of brands carried in the category

MS SKU Count The number of SKUs carried in the category

Industry Trend Category penetration, by competitor, expressed as a percentage

MS Sales Market share sales

MS Ave Inv Marker share average inventory

MS GM Market share gross margin

MS NM Market share net margin
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Store Optimization Parameters
1. Click the Macro and Assortment Optimization workflow tab. 

Figure 6–10 Store Optimization Parameters Worksheet

2. Move to the window option on the toolbar, and select the Store Optimization 
Parameters worksheet.

3. Enter the average number of hours between re-stocking events in the Stock Clerk 
Cycle Time measure.

4. Using the Stock Clerk Success Rate measure, enter the probability rate at which the 
Clerk is successfully able to re-stock shelves when they are below the minimum 
presence.

5. Select Calculate to apply the data.

6. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Table 6–4  Store Optimization Parameters Worksheet Measures

Measure Description

Stock Clerk Cycle Time Average number of hours between re-stocking events

Stock Clerk Success Rate Probability rate that the stock clerk successfully replenishes 
items when they fall below minimum presence
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Store Operating Hours
1. Move to the window option on the toolbar, and select the Store Operating Hours 

worksheet.

Figure 6–11 Store Operating Hours Worksheet

2. Enter the average number of hours per week that the store is open in the 
Operating Hours measure.

3. Select Calculate to apply the data.

4. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Note: Using a smart edit is helpful, especially if all stores within a 
position of the location hierarchy have the same number of hours. At 
the parent level, enter the numeric value followed by 'r'. The value 
entered replicates to each store. The total number of hours appears at 
the parent level.

Table 6–5  Store Operating Hours Worksheet Measures

Measure Description

Operating Hours Average number of hours per week that a store is open for 
business
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Planogram Properties (Ex)
1. Move to the window option on the toolbar, and select the Planogram Properties 

(Ex) worksheet.

Figure 6–12 Planogram Properties Ex Worksheet

2. Enter the space options in the POG Length (Dept) measure.

3. Enter the expected return in values for each of the space amounts in the POG 
Profit (Dept) measure.

4. Select Calculate to apply the data.

5. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Table 6–6  Store Operating Hours Worksheet Measures

Measure Description

POG Length (Dept.) Space amount options to be used in Macro Space Optimization. 
This measures exits at the department and above levels of the 
product hierarchy.

POG Profit (Dept.) Expected return expressed in values for each space amount 
option in the POG length (Dept.) measure. This measures exits 
at the department and above levels of the product hierarchy. 
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Planogram Properties
1. Move to the window option on the toolbar and select the Planogram Properties 

worksheet.

Figure 6–13 Planogram Properties Worksheet

2. Enter the space options in the POG Length measure.

3. Enter the expected return in values for each of the space amounts in the POG 
Profit measure.

4. Select Calculate to apply the data.

5. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Table 6–7  Planogram Properties Worksheet Measures

Measure Description

POG Length Space amount options to be used in Macro Space Optimization. 
This measures exits at the sub-category to department levels of 
the product hierarchy.

POG Profit Expected return expressed in values for each space amount 
option in the POG length measure. This measures exits at the 
sub-category to department levels of the product hierarchy.
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Item Planogram Association
1. Move to the window option on the toolbar and select the Item Planogram 

Association worksheet.

Figure 6–14 Item Planogram Association Worksheet

2. Assign each item to its associated planogram by clicking on the AdmWp 
Planogram mask measure.

3. Select Calculate to apply the data.

4. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Table 6–8  Item Planogram Association Worksheet Measure

Measure Description

Adm Wp Planogram Mask Measure containing the item to planogram assignment 
information. For example, 12oz CranBerry Juice is assigned to 
both Planogram01 and Planogram02. 12oz. Diet Lemonade Tea 
is only assigned to Planogram01.
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Demand by Planogram
If an item is assigned to more than one planogram at the time of optimization, the 
system expects a forecasted demand by Planogram for each item. This information can 
either be provided by loading this information from an external system, or by 
configuring a workflow such that item level demand is spread down to 
item/planogram level demand on a percentage basis, for example, 20% to planogram 
01 and 80% to planogram 02, and so on. This is achieved by configuring a workbook or 
worksheet where users or administrators input these spreading percentages and RPAS 
rules perform the actual spreading.

1. Move to the window option on the toolbar and select the Store Planogram Size 
worksheet.

Figure 6–15 Store Planogram Size Worksheet

2. Assign a number of shelves (APL Wp Number of Shelves) and a shelf size (APL 
Wp POG Shelf Size) to each planogram

3. Roll up the worksheet to all calendar/all location/all planogram and assign the 
Planogram shelf size unit in APL Wp POG UOM.

4. Select Calculate to apply the data.

5. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Table 6–9  Store Planogram Size Worksheet Measures

Measure Description

Apl Wp Number of Shelves Measure containing the number of shelves in each planogram

Apl Wp POG Shelf Size Measure containing the shelf length in each planogram

Apl Wp POG UOM Measure containing the shelf length unit for each planogram
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Assortment Rationalization
Administrative activity that supports the Assortment Rationalization process step 
concentrates on defining thresholds that are used in deriving item rankings and 
defining corporately determined attributes. The Threshold Definitions worksheet 
facilitates the setting of feature, performance, and overall break points. Attributes are 
defined using the Determine Feature Criteria worksheet.

Threshold Definition
1. Click the Assortment Rationalization workflow tab. 

2. Move to the window option on the toolbar, and select the Threshold Definitions 
worksheet.

Figure 6–16 Threshold Definitions Worksheet

3. Enter the lowest numerical value, within a range of 0 and1, for breakpoints in the 
Feature Threshold and Performance Threshold measures. 

4. Enter the break points into the Overall Threshold. These breakpoints should range 
from 1 (low) to 3 (high). As with the measures above, the lower of the range 
should be entered at each breakpoint.

5. Select Calculate to apply the data.

6. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Note: For example, if you wanted to have 3 breakpoints, using 0-.24 
for low, .25-.74 for medium, and .75- 1.00 for high, 0 would be entered 
as the first, .25 would denote the second, and .75 would designate the 
third. Thresholds are used in determining the rank of an item as 
described in the Assortment Rationalization process.

Table 6–10  Threshold Definitions Worksheet Measures

Measure Description

Feature Threshold Breakpoints ranging between 0-1 (low to high) used in 
determining item rank.

Performance Threshold Breakpoints ranging between 0-1 (low to high) used in 
determining item rank.
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Define Feature Criteria
1. Move to the window option on the toolbar and select the Define Feature Criteria 

worksheet.

Figure 6–17 Define Feature Criteria Worksheet

2. Review previously defined types of feature attributes.

3. Enter in the significant attribute features for each feature type.

4. Select Calculate to apply the data.

5. Select Commit Now in the File menu to retain the data; note that you are given the 
opportunity to save the workbook before committing. When finished, a successful 
confirmation box appears.

Next Steps
All of the Administrative functions are now complete. The following chapters cover 
the ability to name and map history to placeholder stores and items.

Overall Threshold Breakpoints ranging between 1-3 (high to low) used in 
determining item overall rank.

Note: The significant attributes are for reference only. They play no 
role in determining item rank other than to remind you that they are 
important to the corporate strategy. It is the understanding that an 
item has none or more of the attribute types that is weighed in the 
ranking.

Table 6–10 (Cont.) Threshold Definitions Worksheet Measures

Measure Description
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7
Like Store

Occasionally, you may want to include new stores (not yet part of the organizational 
hierarchy) in the optimization routine. These placeholder stores may be identified by 
using the Like Store workbook template. For a forecast to be generated, the Like Store 
workbook template also facilitates the mapping history from one store to another. 
Once identified and mapped to a like store, a new store may be included in the space 
and assortment optimization routines.

As with the other workbooks described in this document, the Like Store workbook 
must be created.

Create Like Store Workbook
1. On the Category Management menu bar, select New from the File menu or click 

New on the toolbar. The New window is displayed.

Figure 7–1 New Dialog Box
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2. On the Category Management tab, select Like Store and click OK. The Like Store 
Wizard is displayed. Using this wizard, select the pre-created placeholder store 
positions to name and map history.

3. Select the previously created placeholders and the existing stores to which they are 
mapped.

Figure 7–2 Like Store Wizard - First and Final Page

4. Click Finish. The workbook build begins. This process may take several minutes. 
Once completed, the workbook opens at the Define Like Stores worksheet.

Note: The stores available to map history from must also be chosen 
in this wizard step. 

Note: The selected preexisting stores appear in the pick list of stores 
available for mapping.
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Like Store Workflow Tabs
The Like Store workflow tab is located below the Category Management toolbar and is 
used to access the worksheet supporting the Like Store functionality. The workflow tab 
for the Like Store functionality is as follows:

Define Like Stores
1. Click the Define Like Stores workflow tab. Descriptions of the worksheet fields 

follows this procedure.

Figure 7–3 Define Like Stores Worksheet

2. Enter a description for the placeholder store in the Store Description measure.

3. From the list of stores available in the drop pick list, select the existing stores 
whose history is mapped to the newly described placeholder store.

4. Select Calculate to apply the data.

5. Select Save to retain the information.

6. Select Commit Now in the File menu o commit all of the data in the Like Store 
workbook to the database.

Table 7–1  Like Store Workflow Tabs

Process Step Tab Description

Define Like Stores Placeholder stores are named (described) and a like store is 
chosen for history mapping.

Table 7–2  Define Like Stores Worksheet Measures

Process Step Tab Description

Store Description Text field used for naming the placeholder stores.

Store History map Select list from which stores are chosen to map history.
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8
Like Item

Occasionally, you may want to include new items (not yet part of the product 
hierarchy) in the rationalization and optimization routines. These placeholder items 
may be identified by using the Like Item workbook template. For a forecast to be 
generated, the Like Item workbook template also facilitates the mapping history from 
one item to another. Once identified and mapped to a like item, a new item may be 
included in the assortment rationalization and optimization routines.

As with the other workbooks described in this document, the Like Item workbook 
must be created.

Create Like Item Workbook
1. On the Category Management menu bar, select New from the File menu or click 

New on the toolbar. The New window is displayed.

Figure 8–1 New Dialog Box
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2. On the Category Management tab, select Like Item and click OK. The Like Item 
Wizard is displayed. Using this wizard, select the pre-created placeholder item 
positions to name and map history.

3. Select the previously created placeholders and the existing items to which they are 
mapped.

Figure 8–2 Like Item Wizard - First and Final Page

4. Click Finish. The workbook build begins. This process may take several minutes. 
Once completed, the workbook opens at the Define Like Items worksheet.

Note: The items available to map history from must also be chosen 
in this wizard step.

Note: The selected pre existing items appear in the pick list of stores 
available for mapping. 
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Like Item Workflow Tab
The Like Item workflow tab is below the Category Management toolbar and is used to 
access the worksheet supporting the Like Item functionality. The workflow tab for the 
Like Item functionality is as follows:

Define Like Items
The describing of placeholder items selected in the like item workbook build process 
takes place in the Define Like Items worksheet of the Define Like Items workflow tab. 
It is also on this worksheet that the selection of like items for the purpose of history 
mapping takes place.

Define Like Items
1. Click the Define Like Items workflow tab. 

Figure 8–3 Define Like Items Worksheet

2. Enter a description for the placeholder item in the Item Description measure.

3. From the list of items available in the drop pick list, select the existing items whose 
history is mapped to the newly described placeholder item.

4. Select Calculate to apply the data.

5. Select Save to retain the information.

6. Select Commit Now in the File menu to commit all of the data in the Like Item 
workbook to the database.

Table 8–1  Like Item Workflow Tab

Process Step Tab Description

Define Like Items Placeholder items are named (described) and a like item is 
chosen for history mapping.

Table 8–2  Define Like Items Worksheet Measures

Measure Description

Item Description Text measure used for naming the placeholder item.

Item History Map Pick list of items inside of the workbook from which may be 
chosen to map history.
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